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Course Overview 
 

Discussion 

One of many reasons to use a spreadsheet program like Excel is the programôs ability 

to do calculations and recalculations, when the values change. Formulas make your 

spreadsheets more versatile and hard working. 

Excel offers several timesaving methods for creating and using formulas.  

 AutoSum is available to add rows and columns of numbers.  

 Functions make it easier to perform routine and not-so-routine calculations. 

 AutoCalculate allows you to see the answer to frequent mathematical 
calculations without creating a formula. 

In this course, you will review ways to create and use formulas in Excel worksheets. 

For additional information about formulas, take the course ñExcel 202: More Formulas.ò 

Course Topics 

u Terms to Know 

u Create a Formula 

u Create a Formula with AutoSum 

u Work with Functions 

u Use AutoCalculate 

u Convert the Contents of a Cell from a Formula to a Number 

u Use Absolute Cell Reference 
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Tip ï Open 

a File 

The shortcut 

CTRL + O 

will display 

the Open 

dialog box. 

Conventions Used in This Manual 

In each lesson, there can be: 

 A list of topics  

 A general discussion of the lesson topics 

 A review of several topics  

 One or more exercises 

 One or more tips 

 One or more notes 
 

A topic heading is denoted by the Steps graphic, if a list of general Steps is 

given. Back at your desk, you may refer to these Steps as a basic outline of 

what to do. 

 

An Exercise heading is denoted by the Runner graphic. These classroom 

exercises provide practice and more detailed information about the topic(s) 

being covered. 

 

A Tip box is available to offer a helpful hint or a caution about the topic that is 

being reviewed. 

 

 

A Note provides supplementary information about the current topic. 
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Lesson 1: Terms to Know 

Formula A formula is a mathematical equation that calculates new 
values from existing values.  

Value A value is a number. The number may be a number you typed 
or a number that results from the calculation of a formula. 

Operators Operators are mathematical symbols used to perform 
calculations in formulas.  Some standard operators used in 
Excel are:  
 +  addition > greater than 
 -   subtraction < less than 
 *  multiplication = equal to 
 /   division & concatenate 

Cell 
Reference 

A cell reference, or cell address, identifies a particular cell, 
such as cell D12. Cell D12 is at the intersection of column D 
and row 12. Cell references are used in formulas to indicate 
where a value is stored. 

Order Of 
Precedence 

The order of precedence is the order in which Excel calculates 
a formula. A suggested acronym to help remember the order of 
precedence is PEMDAS, Please Excuse My Dear Aunt Sally. 

PEMDAS PEMDAS represents the order is which the calculations are 
performed in a formula. In each step, Excel will begin at the left 
of the formula and move to the right, as you would read a 
sentence. 
 
Parentheses ï All calculations inside parentheses are 
performed first. 
Exponents ï All values with exponents are calculated. 
Multiplication and Division ï Any multiplication or division is 
performed. 
Addition and Subtraction ï Any addition or subtraction is 
performed. 
 
After the above operations, Excel will perform concatenation 
(indicated by an &). Then, Excel will perform the operations of 
equal to (=), less than (<) and greater than (>). 
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Lesson 2: Create a Formula 

Discussion 

Formulas are mathematical equations that calculate new values from existing values.  

They allow you to use symbols called operators to add (+), subtract (-), multiply (*), and 

divide (/) numbers. In Excel, each formula should begin with an equal sign (=). The 

equal sign tells Excel that everything in the cell is part of a formula. 

Formulas can contain more than just numbers.  They can also contain cell references.  

For example, if you type =B7+C7, Excel will add the values in cell B7 and cell C7.  

Using cell references instead of numbers is usually the best method to use for formulas 

because Excel automatically recalculates formulas if the value in a cell changes. 

Some formula examples are: 

 =B7+C7+D7+E7 Sums the values of the 4 cells 

 =sum(b7:e7) Sums the values of the 4 cells, b7 through e7 

 =g64-g65 Subtracts the value in g65 from the value in g64 

 =(e200/12) *.15 Divides the value in e200 by 12 
Then multiplies that answer by .15 

 =(f24*c10)-(f25*c10) First, multiplies the value in f24 by the value in c10 

Second, multiplies the value in f25 by the value in c10 

Then, subtracts the second value from the first value 

 

 

 

  

Tip ï Typing Cell References 
When you type a cell reference, 

such as D4, in a formula, Excel 

sees d4 and D4 as the same 

reference. Upper or lower case is 

acceptable. 
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Steps  

1. Click in the cell in which to enter the formula. 

2. Type an equal sign = . 
3. Type the formula. 

 Enter cell references or other values. 

 Do not use spaces. 

 Use the math operators (+ - * / > <), as shown on page 4.  

4. Complete the entry by moving out of the cell or clicking on the Enter tool  on the 
Formula bar. 

 
See the formula examples on page 5. 
 
 
To prepare for this lesson: 

1. Open the file Excel 201 ï Formulas lesson 1. 
2. Click on each of the three worksheet tabs (Jan, Feb, Mar) to familiarize you with the 

workbook. 
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Exercise 1  

1. Click on the Jan tab to make it the active worksheet. 
The Jan worksheet displays. 

2. Click in cell E4. 
3. Type the formula =b4+c4+d4 . 

 
In Excel, a formula begins with the equal sign. 
As a rule, there are no spaces in a formula. 

4. Note the color borders which indicate the cells that are referenced in the formula.  
If you cannot see color, the borders still are helpful to verify that the formula is 
correct. 

 

5. Click on the Enter tool  in the formula bar. 
 

 
 
This tells Excel that you have completed your entry for that cell and keeps cell E4 as 
the active cell.  

6. Check your work. 

 Is the formula in the formula bar accurate?  
If changes need to be made, click in the formula bar to place the insertion point 
and make the changes. Then, click on the Enter tool. 

 Review the result of the formula, which is displayed in the cell. 

 
 

7. Click on the Save tool  to save your changes. 
  

Formula, 

the contents 

of the cell 

Result of 

formula 
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Lesson 3: Create a Formula with AutoSum 

Discussion 

The AutoSum tool  is available on both the Home tab and the Formula tab of the 
Ribbon. This tool helps to create formulas for common math operations, such as: 

 Sum a range of values 

 Average a range of values 

 Find the lowest value in a range (Minimum)  

 Find the largest value in a range (Maximum) 

Steps  

1. Click in the cell in which to enter the formula. 

2. Click on the down arrow of the AutoSum tool  . 
3. From the list that displays, select the math operation to perform. 
4. In the formula that Excel creates, verify that the range of cells is correct. 

If not, either type the correct range or use the mouse to select the range. 

5. Complete the entry by moving out of the cell or by clicking on the Enter tool  
on the Formula bar. 
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Exercise 2 

1. Click in cell B10. 

2. On the Home tab of the Ribbon, click on the down arrow of the AutoSum tool . 
 

 
 
A list displays. 

 
3. Click on Sum. 

 
Excel types the formula to add the numbers, using the function sum. 
The formula you see is =SUM(B4:B9) 
 
Note that Excel draws a ñmarqueeò around the cells that are included in the formula. 
 

 

4. Click on the Enter tool  in the Formula bar to accept the formula that AutoSum 
typed. 
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Note: How did Excel choose B4 through B9 (B4:B9)? 

Excelôs instructions tell it to first look above the active cell to look for cells with 

values as their contents. Excel continues to look up until it finds a cell that does 

not have a value. 

If Excel does not find any values when it looks above the active cell, it searches 

to the left. 

5. Click in cell E5. 

6. Click on the AutoSum tool . 
 
If you click on the tool, rather than the down arrow, it defaults to using the Sum 
function. 
 
Excel follows its instructions, as in the Note above. It looks up. Excel does not select 
the group of cells in the row that you want to add. 

 

7. With the mouse pointer as a white cross , drag across cells B5 through D5. 
 
Excel types the correct formula =SUM(B5:D5). 

 

8. Click on the Enter tool  in the formula bar to accept the formula. 
9. Click in cell C5. 

10. Type 1400 and press the Enter key. 
The contents of C5 are revised and the formula results in cell E5 are recalculated. 

11. Click on the Undo tool  to reverse the change made in step 10.   
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Lesson 4: Work with Functions 

Discussion 

Excel includes over 300 preset formulas called functions. Functions allow you to 

perform advanced calculations, such as finding the sum of a range of cells, averaging a 

series of values, or calculating the monthly payment for a loan. For help to create a 

formula that uses a function, click on the function tool  in the Formula toolbar, or 

select the Formulas tab of the Ribbon and click on the Insert Function tool . In 

either case, the Insert Function dialog box is displayed. 

 

 

 

Functions consist of a name followed by one or more arguments in parentheses. 

Arguments are usually numbers or cell references, but they may also be text. 

Arguments can be complex, but in this course, you will use basic arguments like those 

in the function in step 7 of your previous exercise.  

  

Use this box to 

search for 

suggestions of 

functions that 

apply to your 

needs. For 

example, you 

might type 

count 

students.  

Then, click on 

Go. 

In the list of 

suggested 

functions, click 

on a function to 

see its 

description and 

syntax. 

Click on the 

link to get help 

with the 

selected 

function. 
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Look at the parts of the formula that used a function in steps 6 through 8 in Lesson 3. 

 

 

 

 

 

 

 

The basic syntax for a formula that uses a function has three parts: 

a. Equal sign 
b. Function name - The function SUM adds the group of values listed within the 

parentheses that follow. 
c. Argument, enclosed in parentheses - In this formula, you see the argument 

(B5:D5), which is read as B5 through D5. 

As a rule, there are no spaces in a formula.1 This formula adds the values in cells B5 

through D5. The answer to the calculation is displayed in the cell E5, where you placed 

the formula.  

Functions often include references to ranges. A range is a group of cells that all touch 

one another and form a rectangle in shape. In your example, B5:D5 is the range of cells 

to be added.  

A range reference consists of two cell references separated by a colon, such as B5:D5 

or A3:E9. In this second reference, A3 is the upper-left cell in the range and E9 is the 

lower-right cell in the range. A range reference includes all cells within the range. 

  

                                            
1
 ñAs a ruleò means there are some exceptions to the rule. In an argument, the space character could be 

used, because Excel is to type a space or locate a space. 

=SUM(B5:D5) 

Function 

name 

Argument 

Tip ï Cell Contents 
When you enter a 

formula in a cell, the 

content of the cell is 

the formula. The value 

you see (the answer to 

the formula) is 

displayed, but it is not 

the contents of the 

cell. 
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Terms 

Function A function is a preset formula that performs calculations.  
Functions consist of the function name followed by its 
arguments in parentheses.  Some common functions 
are SUM, AVERAGE, MIN, MAX, and COUNTA2. 

Function 
Name 

The function name appears immediately after the equal 
sign.  It tells Excel which function to apply to the 
argument in parentheses. 

Argument An argument indicates the values or cells upon which a 
function will act.  Arguments are usually numbers or cell 
references, but they may also be text. 

Range A range is a group of cells that is rectangular in shape. 

Range 
References 

A range reference is used in a formula or function to 
indicate a group of cells.  Range references consist of 
two cell references separated by a colon, such as 
C3:G18.  

Colon 
Symbol 

A colon symbol inserted between two cell references in 
a formula defines a range of adjacent cells.  It means 
ñthrough,ò as in saying, ñcells C3 through G18.ò 

Syntax The syntax of a function refers to the order of the 
function's arguments.  In some functions, the order of 
the arguments determines how Excel calculates the 
function. 

 

  

                                            
2
 COUNTA counts the number of cells in a range that are not empty. 
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Exercise 3 

1. Be sure that the Jan worksheet is active. 
2. Click in cell E6. 
3. Type =sum(b6.d6 

 
The function typed will add the range of values in cells B6 through D6. 
 
Excel will change the period to a colon and will add the ending parenthesis, when 

the entry is completed by moving out of the cell or clicking on the Enter tool  in 
the Formula bar. 

4. Click on the Enter tool  in the Formula bar. 
 
Your entry is completed. 
Excel calculates, using the formula, and displays the formula results in the cell as a 
value. 

5. Place the mouse pointer on the file handle (the small black square) in the lower right 
corner of the active cell E6. 

 

6. When the pointer looks like a thin black cross , hold down the mouse button and 
drag down to cell E10. 
 

 
 
The formula in cell E6 is copied to cells E7 through E10. This is called AutoFill. 
 
When a formula is copied down to the next cell in a column, Excel changes the 
formula by incrementing the row reference by one. In this example, =SUM(B6:D6) in 
cell E6 is copied to the next cell down as =SUM(B7:D7). 
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7. Use the same procedure to copy the formula in B10 to C10 through D10. 

 
 
When a formula is copied across to the next cell in a row, Excel changes the formula 
by incrementing the column reference by one. In this example, =SUM(B4:B9) in cell 
B10 is copied to the next cell across as =SUM(C4:C9). 
 

8. Click in cell A13. 

9. On the Home tab of the Ribbon, click on the down arrow of the AutoSum tool . 
10. Select Average from the list that displays. 

11. Instead of typing the range E4:E9, use your mouse to select the cells E4:E9. 
 
Excel types the range reference for you.  
You do not need to type the ending parenthesis. 

 

12. Click on the Enter tool  in the Formula bar. 
 
Excel completes the entry and displays the formula results. 
The worksheet looks like this: 

 
 

 

The AutoFill 

Options tool 

allows you to 

select a different 

AutoFill option. 
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Tip ï Including More than One Cell Range in a Formula 

Suppose that you needed a formula that added the North and 

South values for Richards (C4:D4) and for Robbins (C6:D6). The 

formula could be =SUM(C4:D4,C6:D6). A comma is used to 

separate the cell ranges. There are no spaces in a formula. 
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Lesson 5: Use AutoCalculate 
 

Discussion 

The AutoCalculate feature on Excelôs status bar allows you to perform a function without 

inserting it into the worksheet. You can view the answer to common formulas without 

typing the formulas or including the formulas in your worksheet. The common functions 

that are available in AutoCalculate are: Average, Count, CountNums, Max, Min, Sum. 

Steps  

1. Select the range of cells on which to calculate. 

2. Right click on the status bar. 

3. Click to mark the function or functions that you want to calculate. 

4. Press the ESCape key on the keyboard to close the list of status bar options. 

5. Review the formula results in the status bar. 
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Exercise 4  

1. Click on the  sheet tab to make that sheet active. 

2. Select cells E4:E9. 

3. Look at the Sum value on the status bar. 

 
4. If the Sum does not show on the status bar: 

 Right click on the status bar. 

 In the list that displays, click to mark Sum. 

 Press the ESCape key on the keyboard to close the list. 

5. Right click on the status bar. 

6. In the list that displays, click on Sum to remove the checkmark. 

7. Click to mark Minimum and Maximum.  

8. Press the ESCape key on the keyboard to close the list. 

When the minimum and maximum values display, you know that the salespersonsô 

totals for March, range from 2,425 to 75,000. 

 

  

Status 

bar 
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Lesson 6: Convert the Contents of a Cell  
from a Formula to a Number 

Discussion 

When a worksheet is in its final form, you may want to remove the formulas from the 

worksheet, but leave the formula results in place. To do this, follow these steps. 

Steps  

1. Select the cells that contain the formulas to be changed to numbers. 

2. On the Home tab of the Ribbon, click on the Copy tool  . 

3. Click on the down arrow of the Paste tool . 

4. Select Paste Values. 

5. Press the ESCape key on the keyboard to remove the marquee. 

 

To prepare for this lesson:  

 Click on the  sheet tab. 

 Review the formulas in cells E4:E9. 
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Exercise 5 

1. Select the cell or cells that contain the formulas. 
In class, select cells E4:E9. 

 

2. On the Home tab of the Ribbon, click on the Copy tool  .  
The marquee displays to indicate that the copy is made. 

3. Click on the down arrow of the Paste tool . 
A list of choices displays. 

 
4. Select Paste Values. 
5. Press the ESCape key on the keyboard to remove the marquee. 
6. Review cells E4:E9 and note that the cell contents are the formula results, rather 

than the formulas.  
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Lesson 7: On Your Own 

This lesson uses the open workbook, Excel 201 - Formulas lesson 1. 

Exercise 6 

1. On the  tab of the workbook, click in cell E10. 

2. Create a formula to sum the column of numbers.  

One way to do this: 

 Click on the AutoSum tool . 

 Verify that the range E4 through E9 is selected. 

 

 Click on the Enter tool  in the formula bar. 

3. Click in cell F4. 

4. Create a formula to calculate the commissions, which are 10% of sales. 

One way to do this: 

 Type =E4*10% . 

 Click on the Enter tool  in the formula bar. 
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5. Use AutoFill to copy the formula to cells F5 through F9.  

 Be sure that F4 is the active cell. 

 Place the mouse pointer on the file handle (the small black square) in the lower 

right corner of cell F4. 

 When the pointer looks like a thin black cross , hold down the mouse button 

and drag down to cell F10. 
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Lesson 8: Use Absolute Cell Reference 

Discussion 

When a formula is copied from one cell to adjacent cells left or right in a row, Excel 

increments the column reference in the formula by one (1).  

When a formula is copied from one cell to adjacent cells up or down in a column, Excel 

increments the row reference in the formula by one (1). 

What if you do not want Excel to change a row or column reference, when the formula is 

copied? That is when absolute cell reference is used. 

Examples of absolute cell reference: 

=E4*$A12 The dollar sign before the column name, A, indicates that the 

column cannot be changed and must remain as A, when the 

formula is copied. The row reference, 12, can be incremented, 

because it does not have a dollar sign. 

=E4*A$12 The dollar sign before the row name, 12, indicates that the row 

cannot be changed and must remain as 12 when the formula is 

copied. The column reference, A, can be incremented, because it 

does not have a dollar sign. 

=E$*$A$12 The dollar signs are before the column name, A, and the row name, 

12. This tells Excel that the entire cell reference cannot be changed 

and must remain the same when the formula is copied. 
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Exercise 7  

1. Click in cell A11 to make it the active cell. 

2. Type Commission. 

3. Make cell A12 the active cell. 

4. Type 10%. 

 
5. Click in cell G4. 

6. Enter the formula =E4*$A$12 . 

7. Click on the Enter tool  in the Formula bar. 

8. Use AutoFill to copy the formula to cells G5:G10. 

 Place the mouse pointer on the small black square in the lower right border of the 

active cell. 

 When the mouse pointer is a thin black cross , drag down to cell G10. 

 
9. Click in cell A12. 

10. Change the Commission to 12%. 

11. Review the changes in the formula results in column G. 

 


